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Preface 
 

Main motto of any laboratory/practical/field work is for enhancing required skills as well as 

creating ability amongst students to solve real time problem by developing relevant 

competencies in psychomotor domain. By keeping in view, GTU has designed competency 

focused outcome-based curriculum for engineering degree programs where sufficient weightage 

is given to practical work. It shows importance of enhancement of skills amongst the students 

and it pays attention to utilize every second of time allotted for practical amongst students, 

instructors and faculty members to achieve relevant outcomes by performing the experiments 

rather than having merely study type experiments. It is must for effective implementation of 

competency focused outcome-based curriculum that every practical is keenly designed to serve 

as a tool to develop and enhance relevant competency required by the various industry among 

every student. These psychomotor skills are very difficult to develop through traditional chalk 

and board content delivery method in the classroom. Accordingly, this lab manual is designed 

to focus on the industry defined relevant outcomes, rather than old practice of conducting 

practical to prove concept and theory. 

 

By using this lab manual students can go through the relevant theory and procedure in advance 

before the actual performance which creates an interest and students can have basic idea prior to 

performance. This in turn enhances pre-determined outcomes amongst students. Each 

experiment in this manual begins with competency, industry relevant skills, course outcomes as 

well as practical outcomes (objectives). The students will also achieve safety and necessary 

precautions to be taken while performing practical. 

 

This manual also provides guidelines to faculty members to facilitate student centric lab 

activities through each experiment by arranging and managing necessary resources in order that 

the students follow the procedures with required safety and necessary precautions to achieve the 

outcomes. It also gives an idea that how students will be assessed by providing rubrics.  

 

Rapid Prototyping is a dynamic and innovative subject that revolutionizes the traditional 

product development process. It involves the swift creation of tangible prototypes using 

advanced technologies like 3D printing and computer-aided design (CAD). This iterative 

approach allows designers and engineers to quickly visualize, test, and refine their ideas, 

accelerating innovation and driving advancements across various industries. Through this 

subject, students will explore the methods, tools, and applications of Rapid Prototyping, gaining 

the skills to bring their creative visions to life in a faster, more cost-effective manner. 

 

Utmost care has been taken while preparing this lab manual however always there is chances of 

improvement. Therefore, we welcome constructive suggestions for improvement and removal 

of errors if any.  
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Practical – Course Outcome matrix 
 

Course Outcomes (COs): 

Sr. No.  CO statement  

CO-1  Distinguish RP and other related technology.  

CO-2  Understand and use techniques for processing of CAD models for rapid 

Prototyping.  

CO-3  Apply fundamentals of rapid prototyping techniques.  

CO-4  Use appropriate tooling for rapid prototyping process.  

CO-5  Create component with RP applications.  
 

Sr. 

No. 
Objective(s) of Experiment 

CO

1 

CO

2 

CO

3 

CO

4 

CO

5 

1. 
Review of CAD modeling technique and 

Introduction to Rapid prototyping 

√    
 

2. 
Generating STL files from the CAD models & 

Working on STL files. 

 √   
 

3. 

Processing the CAD data in Catalyst software 

(Selection of Orientation, Supports generation, 

Slicing, Tool path generation) 

 √   

 

4. Simulation in Catalyst Software   √   

5. Fabrication the physical part on a RP machine   √   

6. Learning techniques for fabricating an assembly.    √  

7. 

Prepare a CAD model with complex geometry and 

Study effect of slicing parameters on final product 

manufactured through RP. 

    

√ 

8. Assignments      
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Industry Relevant Skills 

 

The following industry relevant competencies are expected to be developed in the student by 

undertaking the practical work of this laboratory. 

1. To aware about CAD software 

2. To aware about graphics standard 

 

Guidelines for Faculty members 

1. Teacher should provide the guideline with demonstration of practical to the students 

with all features. 

2. Teacher shall explain basic concepts/theory related to the experiment to the students 

before starting of each practical 

3. Involve all the students in performance of each experiment. 

4. Teacher is expected to share the skills and competencies to be developed in the 

students and ensure that the respective skills and competencies are developed in the 

students after the completion of the experimentation. 

5. Teachers should give opportunity to students for hands-on experience after the 

demonstration. 

6. Teacher may provide additional knowledge and skills to the students even though not 

covered in the manual but are expected from the students by concerned industry. 

7. Give practical assignment and assess the performance of students based on task 

assigned to check whether it is as per the instructions or not. 

8. Teacher is expected to refer complete curriculum of the course and follow the 

guidelines for implementation. 

 

Instructions for Students 

1. Students are expected to carefully listen to all the theory classes delivered by the faculty 

members and understand the COs, content of the course, teaching and examination 

scheme, skill set to be developed etc. 

2. Students shall organize the work in the group and make record of all observations. 

3. Students shall develop maintenance skill as expected by industries. 

4. Student shall attempt to develop related hand-on skills and build confidence. 

5. Student shall develop the habits of evolving more ideas, innovations, skills etc. apart from 

those included in scope of manual. 

6. Student shall refer technical magazines and data books. 

7. Student should develop a habit of submitting the experimentation work as per the schedule 

and s/he should be well prepared for the same.  

 

Common Safety Instructions 

 

In a Rapid Prototyping Lab, safety is of importance to ensure the well-being of individuals and the 

proper functioning of equipment. By adhering to these safety instructions and exercising caution, 

individuals can create a safer environment for working with rapid prototyping equipment, 

minimizing risks and ensuring successful outcomes in the lab. 
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Index 

(Progressive Assessment Sheet) 

Mechanical Engineering Department 
 

 

 

  

Sr. 

No. 
Objective(s) of Experiment Page 

No. 

Date of 

perform

ance 

Date of 

submiss

ion 

Assessme

nt 

Marks 

Sign. of 

Teacher 

with date 

Remar

ks 

1. 
Review of CAD modeling technique and 

Introduction to Rapid prototyping 

      

2. 
Generating STL files from the CAD models 

& Working on STL files. 

      

3. 

Processing the CAD data in Catalyst 

software (Selection of Orientation, 

Supports generation, Slicing, Tool path 

generation) 

      

4. Simulation in Catalyst Software 
      

5. 
Fabrication the physical part on a RP 

machine 

      

6. 
Learning techniques for fabricating an 

assembly. 

      

7. 

Prepare a CAD model with complex 

geometry and Study effect of slicing 

parameters on final product manufactured 

through RP. 

      

8. Assignments 
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BE SEM VII (MECHANICAL) 

 

Subject: Rapid Prototyping (3171926) 
 

 

Sr. 

No. Title CO 

1 Review of CAD modeling technique and Introduction to Rapid 

prototyping 

1 

2 Generating STL files from the CAD models & Working on STL files. 2 

3 Processing the CAD data in Catalyst software (Selection of 

Orientation, Supports generation, Slicing, Tool path generation) 

  2 

4 Simulation in Catalyst Software 3 

5 Fabrication the physical part on a RP machine        3 

6 Learning techniques for fabricating an assembly. 4 

7 Prepare a CAD model with complex geometry and Study effect of 

slicing parameters on final product manufactured through RP. 

5 

8 Assignments  
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Experiment -1 

Review of CAD modeling technique and 

Introduction to Rapid prototyping 

Objective:   (a)  To understand the basic of Rapid prototyping 

  (b) To differentiate rapid prototyping technique  

Relevant CO: Distinguish RP and other related technology 

1.1 CAD Modeling  

A CAD Model is a computer representation of an object or part. It contains all of the design 

information including geometry, tolerances, materials and manufacturing information. A 3D Model 

is the most general model used in CAD software. There are many geometric models such as 

wireframe; surface and solid model are available. Modeling techniques are decided based on the 

expected utilization of the resulting database later in the design and manufacturing process. 

There are three types of 3D techniques methods. 

a) Wireframe Modeling      b) Surface Modeling        c) Solid Modeling 

a) Wireframe Modeling 

It is the simplest geometrical model an object and used to represent mathematically in the computer. 

It is also called edge representation. Wireframe model consists of points, lines, arcs and circles, 

conics and curves. It doesn‘t require much computer time and memory and hence is considered to 

be the simplest. The major disadvantage is the ambiguous representation of real object and purely 

depends on human interpretation. In fact, the interpretation of the correct object becomes difficult in 

the case of complex model. This limits the application of wireframe models from engineering 

viewpoint. 
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Fig. 1.1 Wire frame model 

b) Surface Modelling 

Shape design and representation of complex object such as bodies of car, ship, airplane etc can‘t be 

represented by wireframe model. In such cases surface models are to be used for precise and 

accurately representation. In comparison to wireframe model, surface models of an object provide 

more complete and less ambiguous representation. In the surface model, the geometry of the object 

is defined without storing any information about topology. For example if two surfaces are joined, 

they share one wireframe entities edge. But neither the surface nor the entities store such 

information. Surface representation can be done in both parametric and nonparametric form. In 

order to use surface for both computation and programming purpose, it is required to develop 

proper equation and algorithms. 

Types of surface available in CAD/CAM systems are, Plane surface, Ruled surface, Surface of 

revolution, Tabulated cylinder, Bezier surface, B-spline surface, Coons patch, Fillet surface, and 

Offset surface. 

 

Fig. 1.2 Surface Model 
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c) Solid Model 

A solid model of an object provides more complete representation than its surface model. The 

database of the solid model stores geometric data and topological information of the corresponding 

object. Geometry is the actual dimension that defines entities of the object whereas topology on the 

other hand is the connectivity and associativity of the object 

For creating solid models of objects various representation schemes have been designed and 

developed. Such scheme are, Half space model, Boundary representation, Constructive solid 

geometry, Sweeping, Analytic Solid modeling, Cell decomposition, Spatial enumeration, Octree 

Encoding, Primitive Instancing. Boundary representation, Constructive solid geometry, Sweeping 

are the most commonly used schemes 

Boundary Representation 

Boundary representation is one of the most popular representation schemes widely used to create 

solid model. A boundary model is based on the topological notion that a physical object is bounded 

by a set of faces. These faces are regions or subsets of closed and orientable surfaces. An orientable 

surface is one in which it is possible to distinguish two sides by using the direction of surface 

normal to point to the inside or outside of the solid model under construction. Each face is bounded 

by edges and each edge is bounded by vertices. The data base of boundary model contains both 

geometry and topology. 

Constructive solid geometry (CSG) 

According to CSG model a physical object can be divided in two set of primitives (basic element or 

shapes) that can be combined in certain order following a set of rules (Boolean operation) to form 

the object as shown in Fig.1.3. Primitives are also valid CSG model. Each primitive is bounded by a 

set of surfaces usually close and orientable. Through boundary evaluation process, the primitive 

surfaces are combined and the boundary of the object is formed in turn, the faces edges and vertices 

are obtained. 
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Fig. 1.3 Constructive Solid Geometry 

1.2 Introduction to Rapid Prototyping 

Rapid prototyping technologies are able to produce physical model in a layer by layer manner 

directly from their CAD models without any tools, dies and fixtures and also with little human 

intervention. RP is capable to fabricate parts quickly with too complex shape easily as 

compared to traditional manufacturing technology. 

RP is capable to fabricate parts quickly with too complex shape easily as compared to 

traditional manufacturing technology. RP helps in earlier detection and reduction of design 

errors. 

1.3 Principle of Rapid Prototyping 

The principal of RP is illustrated in fig. 1(a). The CAD model of the object shown in fig.1 (a) is 

sliced by parallel planes. The edges of the slices thus obtained 1(b) are squared 1(b). Thus a 

complex 3D object is decomposed into several 2D objects or slices. In other words, a complex 

3D manufacturing problem is converted into several simple 2D manufacturing problems. These 

slices are physically realized in one of several ways, stacked and pasted together as shown in 

fig. 1(D), to obtain the physical prototype 1(e). The accuracy of these prototypes, due to the 

staircase effect, can be improved by decreasing the slice thickness. For even better finish, 

polishing can be applied1 (f). Each physical layer will be placed over the previous one. If the 

previous layer is smaller than the current one, then it will not be able to fully support the 

current layer. For this purpose, a complementary shaped sacrificial layer of a different material 

is deposited and fused to the previous layer using one of several available deposition and fusion 

technologies. The sacrificial material has two primary roles: first, it holds the part, analogous to 

a fixture in traditional fabrication techniques: second, it serves as a substrate upon which 

unconnected regions and overhanging features can be deposited. 
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Fig. 1.4 Different models 

The unconnected regions require this support since they are not joined with the main body until 

subsequent layer are deposited. Another use of sacrificial material is to form blind cavities in 

the part. The collection of this sacrificial layer is called support structure. 

1.4 Rapid Prototyping Steps 

There are many different RP processes, but the basic operating principles are very similar. 

Figure shows the data-flow diagram of the basic process. It includes the following steps: 

1. Construct the CAD model 

2. Convert the CAD model to STL format 

3. Check and fix STL file 

4. Generate support structures if needed 

5. Slice the STL file to form layers 

6. Produce physical model 

7. Remove support structures 
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8. Post-process the physical model 

 

Fig. 1.5 Data Flow of the Basic RP Process 

1.5 Classification of Rapid Prototyping Systems: 

 

Fig. 1.6 Classification of Rapid Prototyping Systems 

1.6 Liquid Based Rapid Prototyping System  

Liquid based rapid prototyping systems have the initial form of its material in liquid state. The base 

material can include a resin or a polymer. Liquid based rapid prototyping systems works on the 

principle of ‗Photo curing‘ under which three methods are possible 

i. Single laser beam method ii. Masked lamp method iii. Two laser beam method  

Most of these systems build parts in a vat of photo-curable resin, an organic resin that solidifies under 
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the exposure to laser radiation, in UV range. The laser cures the resin near the surface, forming a 

hardened layer. The formed layer is lowered by an elevation control system to allow the next layer of 

resin to be similarly formed over it. This continues until the entire part is completed. Under liquid 

based rapid Prototyping system, stereo lithography is very unique and patented process which 

combines CAD, CAM, CAE, Laser Scanning, Optical Scanning technologies including chemistry to 

fabricate 3D solid models from 3D CAD data. 

1.7 Solid Based Rapid Prototyping System  

Solid based rapid prototyping systems are meant to encompass all the forms of materials in solid state. 

The solid form can include the shape in the form of a wire, laminate, pellets or a roll. Solid-based rapid 

prototyping systems works on the following principles:  

i. Cutting and Gluing / Joining method. 

   ii. Melting and solidifying / fusing method.  

These processes are different from one another, though some of them use the laser in the process of 

fabricating prototypes. They all utilize solid in one form or the other, as the primary medium to create 

a prototype. 

1.8 Powder Based Rapid Prototyping System  

Powder particles are by-and-large to the particles of solid state in a strict context. However, 

intentionally it is categorized outside the solid-based rapid prototyping systems to refer powder in 

grain form. All the powder based rapid prototyping systems works on the principle of Joining/Binding.  

The method of joining / binding differs for all the systems, in that some employ a laser while others 

use a binder/glue to achieve the joining effect. Binder material is deposited on to selected regions of 

layer of powder particles to produce a layer of powder particles that are completely bonded at the 

selected regions. Iterations would fabricate the desired part. Post-processing is highly required to 

remove the unbounded powder particles. 

1.9 Comparison and selection of Rapid Prototyping Systems  

Optimization of an artifact for characterization of the form using the procedure of computed 

tomography (CT) with geometric dimensioning and tolerances and internal channels and the structures 

those are comparable to that of the cooling channels in heat exchangers. Investigation has been done to 

determine the accuracy and capability of computed tomography measurements and is compared with 

the reference measurements, determined by co-ordinate measuring machine (CMM).  
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The layer height for stereo lithography apparatus (SLA) and selective laser sintering (SLS) are same, 

but the layer height differs for fused deposition modeling (FDM). Thus, SLA and SLS can be 

compared like for like, whereas FDM has to be considered when comparing results.  

Process parameters influence the accuracy of the part fabricated. Also the interactions of process 

parameters influence the dimensional accuracy of the fabricated component. Parameters such as raster 

width, path speed, slice height and tip dimension at two different levels must be taken into 

consideration to determine the influence of these process parameters and their interactions on the 

dimensional accuracy of the part fabricated. Rapid prototyping systems may involve large number of 

contradictory factors that majorly influence the accuracy during the fabrication of the component. A 

standardized methodology of optimization is used to determine the optimum level settings for the part 

fabrication. Thus, experimental and numerical analysis reveals that the control of the process 

parameters of the machine at appropriate levels, improve the dimensional accuracy of the fabricated 

component or part. 

With the availability of growing number of rapid prototyping technologies and their capabilities, it has 

created a problem of selecting the appropriate method to suit the requirement. Thus, IRIS intelligent 

rapid prototyping system selector, an interactive program guides the potential purchaser to select the 

rapid prototyping system which suits the specific requirements. The program‘s database includes 

complete specifications of all systems. Thus, the program is used to compare specifications and 

applications of rapid prototyping system in making the final selection of the suitable method. The 

selection of appropriate rapid prototyping system can also be done on the basis of a quantitative 

analysis. 

The selection of a suitable rapid prototyping process for the required application is facilitated by the 

parameters, orientation for building the component, building cost, manufacturing time, dimensional 

accuracy, and surface finish. The building cost is the primary optimization objective. Volumes of 

building inaccuracy, surface finish, manufacturing time are the secondary optimization objectives to 

resolve the tie-breaks for orientations, for building the model. 

Part orientation for the part fabrication depends on the surface finish, support structure, shrinkage, 

build time, curing and part cost. A support system is developed to facilitate the selection of appropriate 

build direction as well as best suitable rapid prototyping process. The three major factors in 

determining best part orientation are the build time, surface roughness and part cost. A multi-criterion 

decision making method is taken into consideration in order to choose the best part orientation. 

1.10 RAPID TOOLING 
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Hard Tooling 

Rapid Tooling 

A much-anticipated application of rapid prototyping is rapid tooling, the automatic fabrication of 

production quality machine tools. Tooling is one of the slowest and most expensive steps in the 

manufacturing process, because of the extremely high quality required. Tools often have a complex 

geometry, yet must be dimensionally accurate to within a hundredth of a millimeter. 

In addition, tools must be hard, wear-resistant, and have very low surface roughness (about 0.5 

micrometers root mean square). To meet these requirements, moulds and dies are traditionally made by 

CNC-machining, electro-discharge machining, or by hand. All are expensive and time consuming, so 

manufacturers would like to incorporate rapid prototyping techniques to speed the process. Peter 

Hilton, president of Technology Strategy Consulting in Concord, MA, believes that ―tooling costs and 

development times can be reduced by 75 percent or more‖ by using rapid tooling and related 

technologies. 

1.11Classification of Rapid Tooling 

 

  

Fig.1.7 Classification of Rapid Tooling 

1.12 Types of Rapid Tooling 

1.12.1 Indirect Tooling 

 

Most rapid tooling today is indirect: RP parts are used as patterns for making moulds and dies. 

RP models can be indirectly used in a number of manufacturing processes: 

Vacuum Casting: In the simplest and oldest rapid tooling technique, a RP positive pattern is 

suspended in a vat of liquid silicone or room temperature vulcanizing (RTV) rubber. When the 

rubber hardens, it is cut into two halves and the RP pattern is removed. The resulting rubber 

mould can be used to cast up to 20 polyurethane replicas of the original RP pattern. 

A more useful variant, known as the Keltool powder metal sintering process, uses the rubber 

moulds to produce metal tools. Developed by 3M and now owned by 3D Systems, the Keltool 

process involves filling the rubber moulds with powdered tool steel and epoxy binder. When 

Direct Soft 

Tooling 

Indirect soft 

Tooling 

Direct hard 

Tooling 

Indirect Hard 

Tooling 

 

 

Soft Tooling 
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the binder cures, the ―green‖ metal tool is removed from the rubber mould and then sintered. At 

this stage the metal is only 70% dense, so it is infiltrated with copper to bring it close to its 

theoretical maximum density. The tools have fairly good accuracy, but are limited to less than 

25 centimeters in size. 

1.12.2 Direct tooling:- 

To directly make hard tooling from CAD data is the Holy Grail of rapid tooling. Realization of this 

objective is still several years away, but some strong strides are being made. Rapid Tool: A DTM 

process that selectively sinters polymer-coated steel pellets together to produce a metal mould. The 

mould is then placed in a furnace where the polymer binder is burned off and the part is infiltrated 

with copper (as in the Keltool process). The resulting mould can produce up to 50,000 injection 

moldings. In 1996 Rubbermaid produced 30,000 plastic desk organizers from a SLS-built mould. 

This was the first widely sold consumer product to be produced from direct rapid tooling. Extrude 

Hone, in Irwin PA, will soon sell a machine, based on MIT‘s 3D Printing process, which produces 

bronze-infiltrated PM tools and products. 

Quiz 
 

 

1. Explain the working principle of rapid prototyping with neat sketch. 

2. Enlist the various prototyping methods. 

3. Define terms of direct tooling and indirect tooling. 
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Criteria % 10 9-8 7-6 5 

Knowledge 30 

Students give the 

correct answers 

90% or more. 

Student give the 

correct answers 

between 70- 

89%. 

Student give the 

correct answers 

between 50- 

69%. 

Student gives the 

correct answers 

less than 50%. 

Quality of 

report 
35 

Neat 

Handwriting, 

figure, and table. 

Complete 

labeling of figure 

and table. 

Only formatting 

is improper 

(Location of 

figures/tables, 

use of pencil and 

scale). 

A few required 

elements 

(labeling/ 

notations) are 

missing. 

Several elements 

are missing 

(content in 

paragraph, labels, 

figures, tables). 

Participation 20 

Participation 

25% Excellent 

focused attention 

in the exercise. 

Moderately 

focused attention 

on exercise. 

Focused limited 

attention in the 

exercise. 

Participation is 

minimum. 

Punctuality 15 
Timely 

Submission 

Submission late 

by one 

laboratory. 

Submission late 

by two 

laboratories. 

Submission late 

by more than two 

laboratories. 

Criteria % Level of Marks Multiplication Total Remarks 

Knowledge 30  0.3 *_____   

Quality of 

report 

35  0.35*_____   

Participation 20  0.2*_____   

Punctuality 15  0.15*______   

Total Marks   

  

 

 

Teacher Sign  
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Experiment -2 

Generating STL files from the CAD models & Working on 

STL files. 

Objective:   (a) to understand the importance of STL format 

  (b) To make STL format from CAD file 

Relevant CO: Understand and use techniques for processing of CAD models for rapid 

prototyping. 

2.1 Introduction to STL file format 

STL (an abbreviation of "stereo lithography") is a file format native to the stereo lithography CAD 

software created by 3D Systems. STL has several after-the-fact acronyms such as "Standard Triangle 

Language" and "Standard Tessellation Language". This file format is supported by many other 

software packages; it is widely used for rapid prototyping, 3D printing and computer-aided 

manufacturing. STL files describe only the surface geometry of a three-dimensional object without any 

representation of color, texture or other common CAD model attributes. The STL format specifies both 

ASCII and binary representations. Binary files are more common, since they are more compact. 

An STL file describes a raw, unstructured triangulated surface by the nit normal and vertices (ordered 

by the right-hand rule) of the triangles using a three-dimensional Cartesian coordinate system. In the 

original specification, all STL coordinates were required to be positive numbers, but this restriction is 

no longer enforced and negative coordinates are commonly encountered in STL files today. STL files 

contain no scale information, and the units are arbitrary. 
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Fig. 2.1 - CAD Representation of a torus 

Figure 2.1 shows two concentric circles, representing a CAD model of a doughnut shape, and a series 

of triangles approximating the doughnut, representing how STL modeling works. 

2.2 STL file formats 

The STL file format provides two different ways of storing information about the triangular facets that 

tile the object surface. These are called the ASCII encoding and the binary encoding. In both formats, 

the following information of each triangle is stored: 

1. The coordinates of the vertices. 

2. The components of the unit normal vector to the triangle. The normal vector should point 

outwards with respect to the 3D model. 

 

Fig. 2.2- A facet object with three faces and three vertices 

2.3 The ASCII STL file format 

The ASCII STL file starts with the mandatory line: 
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solid <name> 

where <name> is the name of the 3D model. Name can be left blank, but there must be a space after 

the word solid in that case. The file continues with information about the covering triangles. 

Information about the vertices and the normal vector is represented as follows: 

facet normal nx ny nz 

    outer loop 

        vertex v1x v1y v1z 

        vertex v2x v2y v2z 

        vertex v3x v3y v3z 

    endloop 

endfacet 

Here, n is the normal to the triangle and v1, v2 and v3 are the vertices of the triangle. Co-ordinate 

values are represented as a floating point number with sign-mantissa-e-sign-exponent format, e.g., 

―3.245000e-002‖. 

The file ends with the mandatory line: 

endsolid<name> 

2.4 The binary STL file format 

If the tessellation involves many small triangles, the ASCII STL file can become huge. This is why a 

more compact binary version exists. The binary STL file starts with an80-character header. This is 

generally ignored by most STL file readers, with some notable exceptions that we will talk about later. 

After the header, the total number of triangles is indicated using a 4-byte unsigned integer. 

UINT8[80] – Header 

UINT32 – Number of triangles 

The information about the triangles follows subsequently. The file simply ends after the last triangle. 
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Each triangle is represented by twelve 32-bit floating point numbers. Just like the ASCII STL file, 3 

numbers are for the 3D Cartesian co-ordinates of the normal to the triangle. The remaining 9 numbers 

are for the coordinates of the vertices (three each). Here‘s how this looks like: 

for each triangle 

REAL32[3] – Normal vector 

REAL32[3] – Vertex 1 

REAL32[3] – Vertex 2 

REAL32[3] – Vertex 3 

UINT16 – Attribute byte count 

end 

Note that after each triangle, there is a 2-byte sequence called the ―attribute byte count‖. In most cases, 

this is set to zero and acts a space between two triangles. But some software also uses these 2 bytes to 

encode additional information about the triangle. We will see such an example later, where these bytes 

will be used to store colour information. 

2.5 Working with STL file on CAD program 

Virtually all 3D Rapid Prototyping machines and 3D Printers use the STL file format for input. Almost 

all CAD programs have a way to save or export to the STL file format. Following is the list of 

programs that supports exporting the CAD model as STL file format.  



21 

 

Rapid Prototyping (3171926) 

 

 

 
 

2.6 Generating STL files from the CAD models in various CAD software 

3D solid model can be exported to STL file in most of the CAD software. Following are the 

procedures to export 3D CAD file as STL file in some of the famous 3D CAD software packages. 

2.6.1 AutoCAD 

In AutoCAD one can only export 3D solid objects to STL. Following are the steps to generate STL file 

from 3D CAD model in AutoCAD. 

1. At the command prompt type "FACETRES" 

2. Set FACETRES to 10 

3. Type "STLOUT" 

4. Select the objects 

5. Enter Y or hit Enter for Create a binary STL file? [Yes/No] <Yes> 

6. Enter Filename 

7. Save 

2.6.2 Autodesk 3ds Max (3D Studio MAX) 

1.File > Export 

 Alibre 

 AutoCAD  

 Autodesk 3ds Max (3D Studio MAX) 

 Autodesk Inventor  

 Autodesk Mechanical Desktop  

 Bentley Microstation V8  

 Blender  

 Cadkey / KeyCreator 

 Catia  

 CoCreate 

 Creo Direct  

 Creo Elements/Pro  

 Ironcad Pro/ENGINEER  

 Revit Rhino  

 Siemens PLM NX  

 Google Sketchup  

 Solid Edge  

 SolidDesigner 

 SolidWorks  

 Unigraphics  

 Vectorworks 

 Creo Parametric  

 I-DEAS  

 Inventor 
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2.Select type StereoLitho *.stl 

3.Enter Filename 

4.Save 

5.Select Binary 

6.OK 

2.6.3 Catia  

The export to the STL format is only possible in the Part Design environment. If you want to export a 

complete assembly (CAT Product) as a single STL file, you will have to convert the assembly in the 

Assembly Design environment to a CAT Part as follows:  

1. Select the entire product tree  

2. Tools > Generate CAT Part from Product  

3. Enter New Part number  

4. do NOT check: Merge all bodies of each part in one body  

5. OK  

Now you can export the CAT Part in the Part Design environment. The accuracy of the STL file 

depends on the Display accuracy. First set the display accuracy.  

1.Tools > Options...  

1.In the tree select General > Display  

2.select the Performance tab  

3.Under 3D Accuracy select Fixed  

4.Set to 0.02 mm (0.0008 in)  

5.Adjust Curves' accuracy ratio to 0.2  

6.OK  

2.File > Save As  
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3.Enter Filename  

4.Select type stl 

5.Save 

2.6.4 Creo Direct (Creo Elements/Direct, CoCreate, OneSpace, SolidDesigner) 

1.File > Save  

2.Press Select > select the objects (or click All Objects)  

3.Select File Type STL (*.stl)  

4.Click Options  

1.Check Binary  

2.Max Deviation Distance: enter 0.025 mm (0.001 in)  

3.Angle: enter 30°  

5.Enter Filename  

6.Save 

2.6.5 Creo Parametric (Creo Elements/Pro, Pro/ENGINEER) 

1.File > Save a Copy  

2.Select type STL > OK  

3.Select Coordinate System Standard  

4.Check Binary  

5.Set Chord Height to 0 (Pro/E changes it to the smallest allowable value)  

6.Leave Angle Control at the default  

7.Enter Filename > OK 

2.6.7 Autodesk Inventor / Mechanical Desktop 

One can export individual parts or whole assemblies. 
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1.Manage tab > Update panel > Rebuild All  

2.File > Save as > Save Copy As  

3.Select STL  

4.Enter Filename  

5.Select Options  

1.Format > Binary  

2.Units > mm or inches  

3.Resolution > High  

6.Save 

2.6.8 Siemens PLM NX (Unigraphics) 

1.File > Export > STL  

2.Select Output Type Binary  

3.Set Triangle Tol to 0.025 mm (0.001 in)  

4.Set Adjacency Tol to 0.1 mm (0.04 in)  

5.Set Auto Normal Gen to On 

6.Set Normal Display to Off 

7.Set Triangle Display to On 

8.OK  

9.Enter Filename > OK 

2.6.9 SolidWorks 

1.File > Save As...  

2.Set type to STL(*.stl)  

3.Click Options...  
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1.Output as: check Binary  

2.Unit: >Millimetres or Inches  

3.Resolution > Fine  

4.OK  

4.Enter Filename  

5.Save 

2.7 Optimizing an STL file for best 3D printing performance 

The STL file format approximates the surface of a CAD model with triangles. The approximation is 

never perfect, and the facets introduce coarseness to the model. 

 

Fig 2.3 - Effect of degree of approximation in tessellation on Solid geometry 

Figure 2.3 shows the Effect of degree of approximation in tessellation on Solid geometry. The perfect 

spherical surface on the left is approximated by tessellations. The figure on the right uses big triangles, 

resulting in a coarse model. The figure on the centre uses smaller triangles and achieves a smoother 

approximation. 

The 3D printer will print the object with the same coarseness as specified by the STL file. Of course, 

by making the triangles smaller and smaller, the approximation can be made better and better, resulting 

in good quality prints. However, as you decrease the size of the triangle, the number of triangles 

needed to cover the surface also increases. This leads to gigantic STL file which 3D printers cannot 

handle. It‘s also a pain to share or upload huge files like that. It is therefore very important to find the 

right balance between file size and print quality. It does not make sense to reduce the size of the 

triangles ad infinitum because at some point your eye is not going to be able to distinguish between the 

print qualities. 
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Most CAD software offer a couple of settings when exporting STL files. These settings control the size 

of the facets, and hence print quality and file size. Let‘s dig into the most important settings and find 

out their optimum values. 

2.7.1 Chord height or tolerance 

Most CAD software will let you choose a parameter called chord height or tolerance. The chord height 

is the maximum distance from the surface of the original design and the STL mesh. If you choose the 

right tolerance, your prints will look smooth and not pixelated. It‘s quite obvious that the smaller the 

chord height, the more accurately the facets represent the actual surface of the model. 

 

Fig 2. 4 - The chord height (height between the STL mesh and the actual surface) 

It is recommended to set the tolerance between 0.01 millimeters to 0.001 millimeters. This usually 

results in good quality prints. There is no point in reducing this any further, as 3D printers cannot print 

with that level of detail. 

2.7.2 Angular deviation or angular tolerance 

Angular tolerance limits the angle between the normals of adjacent triangles. The default angle is 

usually set at 15 degrees. Decreasing the tolerance (which can range to 0 to 1) improves print 

resolution. The recommended setting for this parameter is 0. 
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Fig 2.5- Angular tolerance (Angle between the normal of adjacent triangles ) 

 

8.7.3 Selection between Binary and ASCII 

Finally, we have a choice of exporting the STL file in binary or ASCII format. The binary format is 

always recommended for 3D printing since it results in smaller file sizes. However, if we want to 

manually inspect the STL file for debugging, then ASCII is preferable because it is easier to read. 

2.8 STL File Manipulation 

Once a part has been converted into STL there are only a few operations that can be performed. This is 

because the triangle-based definition does not permit radical changes to the data. Associations between 

individual triangles are through the shared points and vertices only. A point or vertex can be moved, 

which will affect the connected triangles, but creating a regional effect on larger groups of points 

would be more difficult.  Consider the modeling of a simple geometry, like the cut cylinder in Fig. 2.6a 

Making a minor change in one of the measurements may result in a very radical change in distribution 

of the triangles. While it is possible to simplify the model by reducing the number of triangles, it is 

quite easy to see that defining boundaries in most models cannot be easily done. The addition of a fillet 

in Fig. 2.6b shows an even more radical change in the STL file. Furthermore, if one were to attempt to 

move the oval that represents the cut surface, the triangles representing the filet would no longer show 

a constant-radius curve. 
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Fig 2. 6- STL files of a cut cylinder. 

Here it is to be noted that Note that although the two models in (a) are very similar, the location of the 

triangles is very different. Addition of a simple filet in (b) shows even greater change in the STL file. 

 

 Quiz  
 

1. Explain the importance of graphics standard. 

2. What is .STL file format? Explain the importance of conversation of CAD file into stl format. 

3. Define the terms: Chordal height. 
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Experiment -3 

Processing the CAD data in Catalyst software (Selection of 

Orientation, Supports generation, Slicing, Tool path generation)  

Objective:   (a) to understand about set the process parameter of RP  

  (b) To discuss the effect of process parameter on build quality 

Relevant CO:  (a) Understand and use techniques for processing of CAD models for rapid 

prototyping.     (b)  Apply fundamentals of rapid prototyping techniques.  

3.1 Introduction 

Dimension 1200es printers build models, including internal features, from CAD STL files. Three 

dimensional parts are built by extruding a bead of ABS plastic through a computer-controlled extrusion 

head, producing high quality parts that are ready to use immediately after completion. With two-layer 

resolution settings, you can choose to build a part quickly for design verification, or you can choose a 

finer setting for higher quality surface detail. The Dimension 1200es systems consist of two primary 

components — the Dimension 1200es 3Dprinter and CatalystEX. CatalystEX is the preprocessing 

software that runs on a Windows Vista or Windows 7 platform. The build envelope measures 254 x 

254 x 305 mm (10 x 10 x 12 in). Each material cartridge contains 922 cc (56.3 cu. in.) of usable 

material. 
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Figure 3.1 stratasys 1200es 

 

3.2 CatalystEX overview 

• General tab: 

This section is where you can select the model fill style, support style, change the STL units 

and STL scale. 

• Orientation tab: 

This section allows you to rotate, resize and auto-orient your parts. You can also change the 

view and insert a pause. 

• Pack tab:  

This section shows you which parts are in the pack for printing. You can add parts, arrange the 

parts for a better fit or clear the pack from this section. 

• Printer Status tab:  

This section shows you the amount of material remaining (both model and support) as well as 

which parts are in the Build Queue. 

• Printer Services tab: 
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From this section you can check the printer history, set the printer time, set the printer 

password, update printer software, get printer info and export configuration files(files 

containing specific operating information regarding the printer). 

 

Fig. 3.2 CatalystEX overview 

3.3 Processing your STL file for printing 

Opening your STL file with CatalystEX: 

1. Create an STL file using your CAD software. Refer to your CAD software help section for 

more information about converting your CAD drawings into STL files. 

2. Open the Catalyst EX. 

3. From the File menu select Open STL. 

4. Navigate to and select the STL file that you have created. 

3.4 Selecting layer resolution: 

Layer resolution can be changed on the printer. Changing layer resolution will affect surface finish and 

build times. Selecting a smaller layer resolution creates a smoother surface finish, but takes longer to 

build. Layer resolution also affects the minimum wall thickness. Minimum wall thickness applies to 

the horizontal (XY) plane of your part. If a feature in an STL is smaller than the limit, the modeler will 

increase the size of the feature to the minimum wall thickness. 
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Available layer resolutions Minimum Wall thickness 

.010 inch (.254 mm) .036 inch (.914 mm) 

.013 inch (.330 mm) .047 inch (1.194 mm) 

 

3.4.1 Slicing methods 

1. STL-based Slicing 

• Uniform slicing generates constant layer thickness slices. Adaptive slicing is a variant of 

the uniform slicing, where the spacing between the slices is not constant but determined by 

the geometry and machine capability. 

• However, there are still not 3D printers that fully support or able to take full advantages of 

adaptive slicing. Therefore, uniform slicing seems more versatile. 

2. Direct Slicing 

• Direct slicing can generate precise slice contours from original 3D models and discard the 

error-detection and repairing process of STL files. 

• it can only be used for a specific set of software and machine, and is not applicable to any other 

3D CAD combinations. So , STL-based slicing is still the commonly used method in processing 

the problem of layered 3D printing. 

Slice 

A single, horizontal, cross-sectional cut of a 3D model. Each slice will have support (if 

necessary) and model tool path information for the printer. See Slice Height. 

Slice-Height 

The thickness (magnitude) of each slice. The height will be equal to the amount of material 

extruded to produce each layer of the model. Selection is available from the Resolution Property on the 

General Tab. (Syn: Layer Resolution) 

Slicing 

The action of cutting the 3D STL model into a stack of 2D horizontal part boundary contours 

(slices). The slicing operation begins at the bottom of the model and progresses sequentially to the top 

at a constant interval. 
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3.5 Selecting model interior fill style: 

This establishes the type of fill used for the interior areas of the part. There are three types of 

model interior that you can choose from. 

1. SOLID: Used when a stronger, more durable part is desired. Build times will be longer and 

more material will be used. 

2. SPARSE HIGH DENSITY: This is the default model interior style and is highly 

recommended. Build times will be shorter, less material will be used and the possibility of part 

curl for geometries with large mass will be greatly reduced. 

3. SPARSE LOW DENSITY: The interior will be ―honeycombed‖ or ―hatched‖. This style 

allows for the shortest build times and lowest material usage but will decrease the strength of 

the part. 

 

Fig. 3.3 (A) solid (B) sparse high density (C) sparse low density 

3.6 Selecting support style (Support generation): 

Support material is used to support the model during the build process. It is removed when the part is 

complete. Support styles will affect the support strength and build time of the print. SMART support is 

the default support setting. 

1. BASIC- May be used for most parts. Basic support uses a consistent spacing between support 

tool paths. 

2. SMART - minimizes the amount of support material used, reduces the build time, and 

improves support removal for many parts. SMART supports use a wide spacing between tool 

path raster and change the shape of the support region. As the supports descend from the 

underside of the part feature to the base of the supports, the support region shrinks and 

transforms to a simpler shape to reduce the amount of material used and the build time. 

SMART supports are suitable for all parts, especially those with large support regions, and are 

the default style for builds using soluble supports 
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3. SURROUND- The entire model is surrounded by support material. Typically used for tall, thin 

models. 

3.7 Selecting the scale of your STL files 

Before you process a part for printing, you can change the size of the part within the build 

Envelope.  Every part has a pre-defined size within the STL file. After you have opened the file you 

can change the size of the part produced from the STL file by changing the scale. The scale always 

relates to the original STL file size definition. For example: a cube that is defined as 2 X 2 X 2 can be 

built to be 4 X 4 X 4 by simply changing the scale to 2.0. If after changing the scale to 2.0, you decide 

that a size of 3 X 3 X 3 would be preferred, change the scale to 1.5 - the scale relates to the original 

size of 2.0, NOT the resulting4.0 from the first scale change. Click within the scale input box to type a 

scale of your choice. 

3.8 Selecting the orientation of your STL file: 

It refers to the inclination of the part in a build platform with respect to the X-Y-Z axis. The X & Y 

axis are considered in parallel direction to build platform & Z axis is considered along the direction of 

built part.  

 

Figure 3.2 orientation  

The Orientation tab has an expanded preview window. It provides options for viewing a part, 

measuring a part, orienting a part, processing a part and viewing the layers of a part. How parts 

oriented in the preview window will determine how the part is oriented when it prints. Orientation 

impacts build speed, part strength, surface finish and material consumption. Orientation can also affect 
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the ability of CatalystEX to repair any problems with the STL file. You can choose to auto orient your 

part, which allows Catalyst EX to determine the best orientation for the part for the fastest build time 

and least material usage, or you can manually change the orientation of your part. 

3.9 Orientation Considerations: 

1. Build Speed - Closely related to material use. A lesser amount of supports will allow for a 

faster build speed. Another factor affecting build speed is the axis orientation. The printer can 

build faster across the X-Y plane than it can along the Z axis. Orienting a part so that it is 

shorter within the modeling envelope will produce a quicker build. 

2. Part Strength - A model is stronger within a layer than it is across layers. Depending upon 

what features you want your part to demonstrate, you may need to orient your part to have its 

greatest strength across a specific area. For example, a tab that needs to be pressed would be 

weakest if you are applying pressure across layers. 

 

3. Surface Finish - Much like orienting for strength, how the part is oriented will determine how 

the surface finish will look and allow the printer to provide the smoothest finish for a specific 

area. For example, if building a cylinder, orienting the cylinder upright will have a smoother 

surface finish than building it on its side. 
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4. STL File Repair - It is possible for an STL file to have errors while appearing to be trouble 

free. If the STL file contains errors, Catalyst EX may have problems processing the file. 

Catalyst EX has the ability to automatically correct some STL file errors. How the part is 

oriented can impact this automated repair function. 

3.10 Adding your STL file to the pack: 

The Add to Pack button is found on the General, Orientation and Pack tabs. When you click on the 

Add to Pack button, Catalyst EX will add the file that is currently in the preview window (General tab 

or Orientation tab) to the pack preview window (Pack tab).If the file in the preview window has not 

been processed for printing, processing will occur before the file is added to the pack. Each additional 

click of the Add to Pack button will add another copy of the file to the pack. 

3.11 Printing your STL file: 

The Print button is found on the General, Orientation and Pack tabs. CatalystEX will now process all 

parts in the pack and create a CMB file from which the printer will print the parts. 
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Plotting and path control: 

 

Quiz 

 
1. Enlist the various process parameter of selective laser sintering process. 

2. Define the terms: Hatch Distance, Layer Thickness, and Scanning Speed. 

3. Discuss the effect of layer thickness on mechanical properties. 
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Experiment – 4 

Simulation in Catalyst Software 

Objective:   (a) To simulate the entire process from STL to Physical part 

Relevant CO:  (a) Understand and use techniques for processing of CAD models for rapid 

prototyping.       (b)  Apply fundamentals of rapid prototyping techniques.  (c) Use appropriate 

tooling for rapid prototyping process. 

The simulation was carried out CatalystEX 4.4 software which is used for producing part directly from 

CAD model in Fused Deposition Modeling, which is one of the widely used rapid prototyping process. 

First the CAD model of part to be produced in any high-end modeling software like Nx, Solidworks, 

Creo, Inventor, etc. is converted to STL (Standard Triangulation Language) file format. 

Step 1: open the CatalystEX 4.4 software and import STL file of the part to be produced. 

Step 2: After importing file general properties like layer thickness, model interior, support fill, etc 

should be given. In this software depending on the machine capabilities there are two fixed value of 

layer thickness 0.01 inch and 0.013 inch available. According to the complexity of the part two of this 

value entered. 

 

Figure 4.1 selection of layer thickness 
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Step 3: After selecting layer thickness model interior should be selected. There are three option is 

available: (1) Sparse-low density, (2) Solid (3) Sparse-High density. The effect of this factor is directly 

on the production time and material usage and strength of the part achieved. If Sparse-low density is 

selected then there is less material usage, time of production and strength of part achieved. For Sparse-

High density is selected then there is higher material usage, time of production and strength of part 

achieved and solid option gibe intermediate result of these two options. According to feasibility of the 

part this model interior option should be wisely chosen. 

 

Figure 4.2 selection of model interior  

Step 4: After selection of model interior support fill should be selected. There are four options 

available for support fill: (1) Sparse (2) Basic (3) Smart (4) Surround. This option takes more time of 

production and support material in ascending order. According to part to be produced support fill 

option should be wisely chosen. 
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Figure 4.3 selection of support fills 

Step 5: This option allows to select number of copies pf same part to be produced and STL scale is 

also provided in the software so that scaling of the part can be possible without modifying original 

geometry. As per requirement this option can be used. 

 

Figure 4.4 selection of number of copies to be produced and STL scale 

Step 6: This software allows to change the unit of that STL file without changing the original CAD 

model. 
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Figure 4.5 selections of STL units 

Step 7: Part can be oriented under the orientation option provided by this software. Part orientation 

plays important role to provide proper strength to the part and it saves the support material effectively. 

There are two option available (1) Auto orient (2) Manual orient. By selecting auto orient option 

software automatically set orientation of the part and in manual orientation part can be rotate at 

available degrees about X, Y and Z axis. According to the part to be built proper orientation should be 

selected. 

 

Figure 4.6 selection of part orientation 
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Figure 4.7 selection of manual orientation at diff. degree 

Step 8: After selecting proper orientation add to pack option is to be selected which slice the object 

according to selected value. The below fig shows 0.01-inch layer thickness throughout the part. The 

white color shows the support material and red color shows the model material. This software also 

provides different views of the product by selecting that option. 

 

Figure 4.8 Layer thickness of 0.01 inch throughout the part 
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Figure 4.9 ISO view of the part to be produced 

Step 9: After adding to the pack the pack detail of the part is available under the pack option. Under 

this option main focus is to locate the part where it should be built on palate. This option allows to 

produce number of same part by copy it and remove it also. Name of the part is also edited in this 

option and this option shows the volume of model and support material that will be used to produce the 

part and also shows the time require to build that part.  

 

Figure 4.10 pack details 

Step 10: Finally print option selected to start the production of the part. 
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Reference  

[1] CatalystEx 4.4 software at center of Excellence, LD College of Engineering, Ahmedabad. 

Quiz  

 
1. Explain the step to print the parts in FDM machine. 

2. Discuss the importance of simulation in RP. 
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Experiment – 5 

Fabrication the physical part on a RP machine 

Objective: (a)To understand the entire process of RP 

Relevant CO:  (a) Create component with RP applications.     (b)  Apply fundamentals of rapid 

prototyping techniques.  (c) Use appropriate tooling for rapid prototyping process.  

5.1 Introduction to CAD part 

Rapid prototyping is a group of techniques used to quickly fabricate a scale model of physical part or 

assembly by using three dimensional computer aided design data. Construction of the part usually has 

done using 3d printing or additive layer manufacturing technology. As with CNC subtractive methods 

the computer aided design , computer aided manufacturing CAD-CAM workflow in the tradition rapid 

prototyping process start with the creation of geometry data, either as a 3d solid using a cad 

workstation, or 2d slices using a scanning device. For rapid prototyping this data must represent a valid 

geometric model whose boundary surfaces enclose a finite volume contain no holes exposing the 

interior, and do not fold back on them. In other word the object must have an ―inside‖. The model is 

valid if for each point in 3d space the computer can determine uniquely whether that point lies inside, 

on the boundary surface of the model.CAD post process will approximate the application vendors 

internal CAD geometric forms with a simplified mathematical form, which in turns is expressed in a 

specified data format which is common feature in additive manufacturing : STL ( stereo lithography ) a 

de facto standard for transferring solid geometric models to SFF machine. 

After the STL file is provided as an input to the RP machine using the CATALYST software, the 

orientation is set as per the support material estimation and also the time duration required. Here the 

detail drawing of the printed part is on below fig. 5.1 CAD model was developed in SOLIDWORKS 

2017. 
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FIG-5.1 CAD MODEL IN SOLIDWORK 

 

Fig. 5.2 detain drawing of printed component 

5.2 Machine Specification 

Height / width /depth   1143/737/838 

Weight     148 kg 

Model material   ABS plus in nine material 

Support material   Soluble (SST 1200es) :breakaway (BST 1200es) 

Layer thickness   0.33mm 

Scale      1:1 

Model interior fill style  Sparse High Density 

Support style    smart 

3D Model    shown in fig 5.3 

Power requirements 100-240 V AC – 7A 50 Hz 1200 W dedicated circuit within 2m 

do not use extension cord or a power trip, using these can 
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possibly cause intermittent power issues. 

Air Circulation 115mm minimum space behind printer for air circulation. 153 

mm minimum space around printer for air circulation 

Environment 15 ‗C to 30 ‗C 

Relative humidity range 30 to 70 percent, non condensing 

Heat emission 1080 watts=3686 BTU / hr typical 

1380 watts = 4710 BTU /hr Max 

 

Fig. 5.3 Dimensions SST 1200ES 
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Fig. 5.4 Component Loading 

Part developed after then post processed and is being separated from the support material. Here part 

developed does not involve complex feature and hence it does not involve post processing and removal 

of support material through the help pf chemical solvent. Here the support material can be separated 

from the part directly by tearing it off. Final part is shown in fig. 5.4 this part was used for flexural 

strength test as per ASTM standard ASTM – D790 for material characterization of ABS plastic. 

 

Fig. 5.5 Printed Part 
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Quiz  

 
1. Enlist various command which is being used in FDM and SLA machine. 

2. How to set process parameter while printing parts on SLA? 
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Experiment- 6 

 Learning techniques for fabricating an assembly 

Objective: (a)To understand the entire process of RP 

Relevant CO:  (a) Create component with RP applications.     (b)  Apply fundamentals of rapid 

prototyping techniques.  (c) Use appropriate tooling for rapid prototyping process.  

 

6.1 Introduction 

An assembly is an end product consisting of solids in point, line or surface contact. The solids 

made of different materials. The contacts can be stationary, rolling or sliding. Assemblies can be 

articulated by having moving contacts. 

The traditional approach fabrication involves producing paths first and then assembling them 

one by one. The process of assembly itself can be manual or automated through mechanized or robotic 

automation. Much if the progress in assembly modeling has occurred from this traditional viewpoint. 

There are four techniques of representation and reasoning techniques for fabricating an 

assembly in rapid prototyping: 

1. Algorithmic  

2. Knowledge based  

3. Expert system based 

4. ANN-based 

Many representational and reasoning schemes have been proposed to address issues such as 

tolerance and mating, connectivity and mating, connectivity and precedence and assembly directions. 

Almost all these issues are closely related to the mating features on the pans. Hence, progress in 

assembly modeling has closely related 10 the mating features on the pans. Hence, progress in assembly 

modeling has depended much on progress in geometric and technological feature recognition. 

6.2 Design consideration in assembly 
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 Tolerance 

 Mating 

 Connectivity 

 Precedence 

 Assembly direction 

Almost any RP process that can deposit more than one material in each layer and with supports 

easily removed can be modified to build MM assemblies. When multi-material assembly is made by 

means of layer-based RP process, all component regions within each layer are built within the 

corresponding layer build cycle. Hence may traditional assembly issues such as precedence and 

assembly direction become irrelevant. However, information regarding location dimensions, tolerance, 

mating relationships and mating types continues to be highly important. 

6.3 Approaches of fabrication of assembly 

6.3.1 Layer based fabrication methods approach 

In fabricating articulated assemblies using layer-based fabrication methods approach, a graph 

model organizes components in the given assembly by their boundary mating intonation to create an n-

manifold (NM) representation. An NM is a connected point set where every point has a neighborhood 

topologically equivalent to an open ball of En. Local mating information is also explicitly represented, 

so slicing operations can be performed directly on model. In particular, slicing is performed using a 

dexel encoding approach that eliminates the need for intermediate tessellation of curved bounding 

surfaces. 

6.3.2 Dexel Approach 

The object is intersected by set of parallel and equidistant rays (i.e., infinite straight lines). Next 

the points of intersection of each ray with the object are noted. Each pair of points defining a straight-

line segment. That is totally inside a given object material makes up a dexel. Drexel‘s corresponding to 

different material regions within the ray via are identified through an algorithmic approach. 

The dexels so obtained are fleshed out into boxes, so the object can be approximated by 

resulting collections of boxes corresponding to different material regions. Thus, alter slicing the MM 

assembly, there will be different 2 D regions of the heterogeneous materials. The dexel model of the 

object is then combined with the 3D assembly model to assimilate mating intonation. 

Tolerances are appended to the end points of each dexel such that positive, negative, and zero 

values indicate interference clearance and neutral fits respectively. Collision free tool paths (path of 
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liquefier heads in FDM) are calculated on the basis based of a longest first scheduling approach. This 

novel approach facilitates Filling of MM regions simultaneously and efficiently. 

6.4 Inevitable impact on assembly and joining operations 

An assembly is a collection of manufactured parts, brought together by assembly operations to 

perform one or more of several primary functions an assembly operation is defined as the process or 

series of acts involved in actual realization of an assembly. Joining finalizes assembly operating and 

generates joints. 

6.5 Virtual Assembly Analysis (VAA) 

The current design and analysis practices for verifying a design concept are usually performed 

after selecting a final design concept. Prediction of various effects corresponding to specified assembly 

processes in up-front design is critical to understanding the performance of an assembly. VAA is a 

transparent and remote virtual simulation and testing paradigm utilized in a service-oriented 

collaboration environment. A VAA tool embedded in the assembly design process can be used to 

represent an assembly and imply the physical effects of a joint. 

6.6 Assembly design formalism and assembly design model generation 

The assembly design formalism specifies assembly/joining relations symbolically and it is used 

as the mechanism to perform product assembly design tasks. This assembly formalism is comprised of 

five phases: spatial relationship specification, mating feature extraction, joint feature formation and 

extraction, assembly feature formation and assembly engineering relation construction. By 

interactively assigning spatial relationships the designer can assemble components together to make 

friar products and infer the degrees of freedom remaining on the components. 

In assigning spatial relationships, mating features are defined and extracted from parts. Mating 

feature extraction is a preliminary step to capturing joining information. This process provides 

geometric information directly related to assembly operation. 

The mating feature is not sufficient to represent a joining operational. The designer can specify 

specific joining methods and constraints such as welding conditions and fixture locations in joint 

features. 

Assembly engineering relations of the entire assembly are constructed based on the assembly 

features after specifying the spatial relationships and joining relationships between components. The 

mating binds and an assembly relation model are used to represent the engineering relationships on the 
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entire structure. Their approach was to represent all of the assembly design concepts explicitly and also 

in a universally acceptable manner. 

References: 

1. ―Rapid prototyping: laser based and other technologies‖, Patri K. Venuvinod, weiyin Ma, pp. 

334-340 

 

Quiz  
1. Define term: allowance, tolerances. 

2. Enlist various approach for assembly. Explain pros and cons of them. 
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Experiment- 7 

Prepare a CAD model with complex geometry and Study effect 

of slicing parameters on final product manufactured through 

RP. 

Objective: (a) to understand the effect of process parameter on final product 

Relevant CO:  (a) Create component with RP applications.      

(b)  Apply fundamentals of rapid prototyping techniques.  

7.1 Introduction: 

Rapid prototyping is finding applications in diverse fields in the industry today, with prototypes used 

for form, fit and function. Design engineers around the world use rapid prototyping to pre estimate 

product characteristics like shape, manufacturability and finish. Especially when it comes to 

manufacturing precise parts like aerospace components and parts with critical dimensions, it becomes 

imperative to check for surface finish a good surface finish on the parts helps eliminate dimensional 

inaccuracy and cost due to subsequent post processing of the part to attain the desired surface finish. 

Common surface finishes include the staircase effect, chordal effect, support structure burrs and errors 

due to starting and ending of deposition. Fused deposition modeling is a layered manufacturing 

process. In all layered manufacturing process the slicing of the CAD model leaves a characteristic 

effect called the staircase effect on the part produced. This error cannot be eliminated but can be scaled 

down by reducing the slice thickness.  

The chordal error is induced when STL files are generated from the CAD model. All the curved 

surfaces in the CAD model are approximated as a series of triangles, hence leading to a non-smooth 

surface. A rough solution to this problem is to do a positive offset to the surface , build the prototype 

and then do surface finishing operation to bring it back to the original. This would however never 

result in a perfect model. It is confirmed that the surface finish problem cannot be completely 

eliminated. Hence one has to come up with a way to reduce the problem by a certain degree. This can 

be done by careful process parameter control. 



60 

 

Rapid Prototyping (3171926) 

 

 

 

Figure 7.1 slicing of solid model 

 

 

 

 

 

 

A number of algorithms have been reported for slicing faceted models with uniform layer thickness 

(Luo and Ma 1995 and Liao and Chiu 2001a and references therein). Some researchers have also 

explored adaptive slicing using a variable layer thickness (Tata et al. 1998 and Tyberg and Bohn 

1998). This section focuses on the basic slicing algorithms applicable to a faceted surface model with 

uniform slicing. Adaptive slicing will be discussed in the next section together with direct slicing. To 

efficiently perform model slicing for rapid prototyping applications, the input STL geometry must be 

organized in a concise data structure. 

7.2 Model Slicing and Skin Contour Determination 

A STL facet model used for rapid prototyping applications contains a collection of planar faces. These 

faces define an approximate boundary representation for the object. During subsequent tool path 

generation, we need to slice the model based on either uniform layer thickness or adaptively variable 

layer thickness. In this section, we use uniform slicing to illustrate the slicing algorithm. As for 

adaptive slicing, one only needs to determine the corresponding adaptive layer thickness and the 

slicing algorithms are the same. A generalized discussion of adaptive slicing will be presented in the 

next section. 

Based on a user-entered layer thickness, a sequence of parallel slicing planes can be defined for model 

slicing. As a convention, we assume that the model has been properly oriented such that the z-axis will 

be the building direction. Let d be the layer thickness and n be the total number of slicing planes 

excluding the bottom plane with z = Zmin that are not used during the slicing procedure. Further, let 

Zmax and Zmin be the extreme z-coordinatesof the STL model. The total number of layers (valid 

slicing planes) required is then defined by the following equation 
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Figure 7.2:  a) top down approach b) bottom up approach c) nagative tolerance d) 

positive tolerance 

 

For RP applications, one further needs to convert the surface contour points into skin contour points 

for later tool path generation. The determination of skin contours is mainly based on the tolerance 

requirement. Figure 5 -26 illustrates several cases with different tolerance requirements. 

Figure a) shows a model produced using a 'top-down' approach. All the computed surface contours are 

directly used as skin contours for the current layer for model prototyping. 

Figure b) shows a model produced using a 'bottom-up' approach. The computed surface contours are 

directly used as skin contours of the next layer. 

Figure c) shows a model produced with negative tolerance. The produced model is always smaller than 

the actual computer model. 

Figure d) shows a model produced with positive tolerance. The produced model is always larger than 

the computer model. 

 

 

 

 

 

 

 

 

 

7.3 Direct and Adaptive slicing: 

This section addresses adaptive slicing for obtaining a smooth surface finish while ensuring high 
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building speed. Instead of working with a STL model, direct slicing algorithms are presented, i.e., the 

algorithms directly work with a CAD model. The discussion is mainly adapted from Ma et a!.(2003b) 

on· direct slicing of a NURBS-based surface model, but is applicable to all parametric surface or B-rep 

solid models. The general approach is also based on the work reported in (Kulkarni and Dutta 1996) on 

generic adaptive slicing and (Dolenc and Makela 1994) on adaptive slicing of a STL model. The 

procedure is subdivided into the following major steps. 

Peak feature point identification: When producing prototype models with uniform layer thickness, 

there is no guarantee that important features of an object, such as horizontal features and other 

important feature points, are properly reproduced. With adaptive slicing, one can place a layer 

anywhere and hence all the peak features can be reproduced on the prototype model. In order to do so, 

all the peak features in a CAD model are first identified from the model surfaces as a set of feature 

points. These feature points subdivide the CAD model into slabs along the slicing direction, i.e., the z-

direction. 

 

 

Figure 7.3 normal slicing and adaptive slicing 

Adaptive slicing with arbitrary tolerance control: An adaptive slicing algorithm based on surface 

curvature along the vertical direction at the reference level/points is applied to each of the slabs with a 

pre-specified cusp height tolerance, and the minimum and maximum layer thickness. The skin 

contours on each layer are obtained from the allowable layer thickness, the local geometry information, 

and the given tolerance. 
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7.4 Adaptive layer thickness determination: 

The tolerance requirement of a RP part is an important input for layer thickness determination. The 

tolerance distribution can be either negative, positive or a combination of both as illustrated in Figure 

c. The negative tolerance shown in Figure 5-33a can be used for situations where the fabricated RP 

part acts as a core pattern. The positive tolerance shown in Figure 5 -33b is often used in situations 

where a post-treatment operation, such as polishing, can be entertained. Both the cases of negative and 

positive tolerances are addressed in (Kulkarni and Dutta 1996) as a containment problem. In other 

general situations, a mixed tolerance as shown in Figure c might be desirable for faithfully representing 

the model shape or for satisfying other fitting conditions. This section provides a generalization of the 

containment problem where the user may use an arbitrary combination of both negative and positive 

tolerances. It is therefore possible for users to control the fitting conditions irrespective of whether the 

RP model is to be  used as a core pattern or is followed by some post treatment operations. In this case, 

the same distribution of the mixed tolerance occurs at all layers. This feature is different from the 

situation pointed out in (Sabourin et a l.1996, Kulkarni and Dutta 1996) where the RP part is skewed. 

 

 

 

 

 

Figure 7.4: a) negative tolerance b) positive tolerance c) mixed tolerance 

7.5 Identification of peak features: 

Peak features of an object are easily missed when performing slicing in Layered manufacturing ( 

Dolenc and Makela 1 994). Figure 3 illustrates two slicing strategies. All the peak features are 

preserved with the second strategy shown in Figure 3 b. This is however not the case for the first 

strategy shown in Figure 3 a. A peak feature may occur at places including a corner, a boundary curve, 

and an interior area of a surface. A peak feature may also be a horizontal edge or a horizontal face. For 

the purpose of layered manufacturing, all peak features can be handled with characteristic/feature 

points on the individual surfaces. 
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Figure 7.5 (a) peak features lost with uniform slicing;  (b ) peak feature preserved with adaptive 

slicing 

Quiz  
1. Discuss the effect of layer thickness on curve surface. 

2. How can overcome the issue related high layer thickness. 
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